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What's New in Version 2026

This document describes the enhancements added in Sage 100 version 2026. Changes 
to the Sage 100 Desktop are listed first, followed by global changes, installation changes, 
module-specific changes, and then integrations.

Depending on your purchase agreement, some features described here may not be 
available in your product.

Note: The Sage 100 2026 release features 20 suggestions from customers and 
business partners via the Sage 100 ideas site and other channels. 

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit 
the ideas site to share your ideas and vote for your favorites.

Your Sage 100 business partners at work! This idea was a suggestion from 
90 Minds, Inc. where “More Minds Are Better Than One.”

Sage 100 Desktop Changes
The following changes were made to the Sage 100 Desktop.

Sage Help Agent

Use the new AI-powered Sage Help Agent to find answers to your Sage 100 questions. 
On the Home tab, click the Sage Help Agent button to use the agent in your Desktop 
browser. 

Ask a question about what you want to do or know, and the agent will guide you to the 
correct information in Sage 100 help. You can also access the agent on the Information 
Center page.
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Global Changes

Global Search of Sage 100 Data

On the Home tab, click the Global Search button to perform a global search in Sage 100 
data. For example, you can search to find all inventory items that are in a specific default 
warehouse or all Accounts Receivable invoices associated with a specific salesperson.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Global Changes
The following changes are carried throughout multiple modules.

Expanded Lot/Serial Number Field

The lot/serial number field has expanded from 15 to 50 characters in length in the 
following modules: Accounts Receivable, Bill of Materials, Common Information, 
Inventory Management, Mobility for Bar Code, Production Management, Purchase Order, 
Return Merchandise Authorization, and Sales Order.

The following changes have been made for this feature:

 l In Inventory Management Options, the Zero Fill Lot/Serial Number check box has 
been added, giving you the option to insert leading zeros automatically to pad 
numeric lot/serial numbers.

 l Lot/Serial number entry fields display the full 50 characters (for example, Lot/Serial 
Number Distribution and Next Lot/Serial Number field).

 l Lot/Serial number columns in list views display 20 characters and can be expanded 
to display the full 50 characters (for example, Lot/Serial Transaction Inquiry and 
Lot/Serial History Inquiry).

Existing lot/serial numbers are not automatically converted to the new length.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Lot/Serial Number Conversion Utility

The Lot/Serial Number Conversion Utility has been added to the Utilities menu. In the 
Sage 100 Desktop, select File > Run. In the Run Program window, enter *utl in the 
Program field to open the Utilities menu.
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Use this utility if you want to convert your existing numeric lot/serial numbers to the new 
length of 50 characters by inserting leading zeros. Lot/Serial numbers containing 
characters, or a combination of numerics and characters will not be changed.

Expanded Price Level Field

The Price Level field has been expanded from 1 to 15 characters in the following 
modules: Accounts Receivable, Customer Relationship Management, Inventory 
Management, eBusiness Manager, Job Cost, Return Merchandise Authorization, and 
Sales Order. Task windows, forms, and reports have been updated to reflect this change.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Expanded Package Tracking Number field

The Sales Order Package Tracking Number field has been expanded from 30 to 40 
characters to fit the longer tracking numbers used by shipping carriers and services, such 
as FedEx Ground and DHL eCommerce. Task windows, forms, and reports have been 
updated to reflect this change.

New Filter Option for Custom Lookup Views

In the User Lookup Wizard, the filter option Is Empty has been added to the Operand field 
in the custom filters screen.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Lookup Listing Prints All Modified Lookups

A Print button has been added to the User Lookup Wizard, enabling you to print the 
Lookup Listing with all default and modified lookups. The Level column on the listing 
indicates where the lookup was modified. For more information, see User Lookup Wizard 
in Sage 100 help.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Installation Changes

User Interface Enhancement

To make it easier to access data and complete tasks, in A/P Invoice History Inquiry, A/R 
Invoice History Inquiry, and RMA Inquiry, hyperlinks to related tasks (such as Vendor 
Inquiry or Customer Inquiry) have been added where applicable.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Show/Hide Password

Click the new Show/Hide ( ) button next to each Password field in Sage 100 to double-

check the value you're entering. After tabbing off the Password field, the password can no 
longer be viewed.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Installation Changes
The following installation changes were made.

64-bit Version of Sage 100

Important! Sage 100 2026 is a 64-bit only application.

 l If you’re installing on a server with an earlier 32-bit version of Sage 100 2021–
2025 installed, the 32-bit version will no longer work.

 l Before installing Sage 100 2026, we recommend converting any earlier 32-bit 
versions to  64-bit using the 32_64_Bit_Switch_Utility.exe. For more information, 
see the Customer Upgrade Guide.

 l If running the switch utility is not possible, then install Sage 100 2026 on a 
server that does not have a 32-bit version installed.

Sage CRM Installation Changes

The option to Install Sage CRM or Upgrade Sage CRM has been removed from the 
Sage 100 installation program. For information on installing or upgrading Sage CRM, see 
the Sage CRM Help Center.

Use the Sage 100 2026 CRM file to integrate Sage CRM with Sage 100. 
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SAP Crystal Reports 2025

SAP Crystal Reports has been updated to version 2025. Crystal runtime components are 
SP34 for both x86 and x64.

Product Key Registration Improvements

When installing and registering Sage 100, the full product key can now be pasted into the 
first segment of the Product Key field and the system automatically splits the key across 
all segments for your ease.

Custom Office
The following change was made in the Custom Office module.

Tables with User-Defined Fields Flagged for Easy Visibility

In User-Defined Field and Table Maintenance, to help you identify tables that have one or 
more UDFs defined, the [UDF] tag now displays after the table name. You can also use 
the Table Search feature to search for UDF and all tables with this tag will display.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Inventory Management
The following changes were made in the Inventory Management module.

Track Lot Code Source

You can now track lot code source and country of origin for items on the FDA Food 
Traceability List (FTL) that must be tracked per the Food Safety Modernization Act 
(FSMA). The lot code source is a 50-character alphanumeric field that identifies the 
location where the original lot code was assigned. 
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Inventory Management

The following changes have been made:

 l Changes in Inventory Management Options:

 l The Lot/Serial Expiration options originally on the  Additional tab have been 
moved to the new Lot/Serial tab.

 l The Enable Tracking of Lot Code Source check box has been added on the 
Lot/Serial tab.

 l The Track Lot Code Source check box has been added in Item Maintenance and 
Product Line Maintenance.

 l The Lot Code Source and Country of Origin entry fields have been added in the 
Lot/Serial Number Distribution window accessed from I/M Transaction Entry, 
Physical Count Entry, S/O Invoice Data Entry, P/O Receipt of Goods Entry, RMA 
Entry, and RMA Receipts Entry.

 l The Lot Code Source History Report has been added on the I/M Reports menu.

Note: This feature is available if you purchased Sage 100 through a subscription 
plan.

Improved User Workflow

The order of tabs in Product Line Maintenance has changed to support a more efficient 
user workflow. Lot/Serial is now the second tab, and Accounts is the third.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Improvements for Calculating Inventory Quantity Available

In Inventory Management Options, two new options have been added in the Include in 
Quantity Available field: Required for W/Ts and POs and Required for W/Ts. 

These options calculate the quantity available by only including the quantity required for 
work tickets (materials) and excluding the quantity on work tickets (finished goods). This 
allows the raw materials to be included in the calculation so that the component 
availability is not overstated and the finished goods availability is not overstated.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Sage 100 What's New Guide 6



Inventory Requirements Planning
The following change was made in the Inventory Requirements Planning module.

Warehouse Groups

You can now define one or more warehouse groups in Warehouse Group Code 
Maintenance, a new task on the Setup menu. Warehouse groups are used by the 
IRP Generation process to consolidate recommendations for material acquisitions or to 
recommend the transfer of inventory from one warehouse to another. This functionality 
was in the Material Requirements Planning module and has now been added to IRP.

This feature includes the following changes: 

 l The Enable Warehouse Grouping check box has been added in Inventory 
Requirements Planning Options. 

 l The Warehouse type field has been added in Warehouse Code Maintenance, and 
you can identify a warehouse as a Standard or Transfer type.

 l When warehouse grouping is turned on, Items to Produce/Purchase, Item Detail, 
IRP Inquiry, and the Inventory Requirements Planning Report display information for 
warehouse groups.

Library Master
The following changes were made in the Library Master module.

Enhanced Password Validation and Security

On the System Configuration Security tab, the password setting options in the Internal 
Security section are now available and selected by default. This change enables 
password validation to occur, whether passwords are required or not.

In addition, the Maximum Hours Session Can be Inactive field has been added to 
improve security. You can set the number of hours the software can be inactive before a 
user is automatically logged out.
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Library Master

User Interface Improvement in Company Maintenance

In Company Maintenance, the Payments tab has been renamed Integrations to describe 
the options available. Also, the Enable Sync for Sage Supply Chain Intelligence check 
box has been added.

Audit Tracking for Roles and Users

You now have the option to retain an audit trail of all changes, deletions, and additions to 
role and user information. This feature includes the following changes:

 l In System Configuration, the Enable Audit Tracking for Role and User 
Maintenance check box has been added. 

 l The new Role Audit Report and User Audit Report are available on the Reports menu 
when audit tracking is enabled.

 l Click the Purge button on the audit report to access the Purge Role Audit Report or 
Purge User Audit Report utility. You can also access these tasks on the Utilities 
menu.

 l In Role Maintenance and User Maintenance, click the new Audit Viewer button to 
view changes in the Audit Activity window. This feature is available if the user has 
permissions to the audit reports in Role Maintenance.

New Form Printing Message for Subscription-Only Installs

After forms are printed, a message appears to remind you to remove forms from the 
printer and replace with paper. If you don't want this message to appear, you can turn it 
off in Role Maintenance. 

To prevent confusion, this message is now two separate messages. If you're on a 
subscription-only install, the message now refers to the Role Maintenance Security 
Options tab. If you're on a non-subscription install, the message refers to the Role 
Maintenance Module Options tab.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”
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Paperless Office
The following changes were made in the Paperless Office module.

Consolidated Emails for  Customers and Vendors

You can now consolidate multiple forms into one email for a specific customer or vendor 
and selected form. For example, if you're sending 10 invoices to a customer, then only 
one email with all 10 invoices will be sent instead of 10 individual emails.

You also have the flexibility to zip multiple forms into a single attachment on consolidated 
emails, and you can schedule the delivery of consolidated emails using Task Scheduler.

This feature includes the following new options:

 l Consolidate E-mails check box in Default Delivery Options

 l Consolidate E-mails for Customer check box and Consolidate E-mails for Vendor 
check box in Paperless Office Delivery Options

 l Zip Multiple PDFs on Consolidated E-mails check box and Minimum Number of 
PDFs to Zip field in Paperless Office Options

This feature includes the following new tasks on the Paperless Office Main menu:

 l Deliver Consolidated Customer E-mails

 l Deliver Consolidated Vendor E-mails

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Print Sales Order Picking Sheets to PDF

You can now print Sales Order picking sheets to PDF and email them to recipients in the 
warehouse. When Paperless Office is set up for forms, the Paperless button is available 
in Warehouse Code Maintenance. Click this button to define default email recipients for 
the selected warehouse in the new Paperless Office Delivery Options (Warehouse Code 
Maintenance) task.
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Paperless Office

If there's a business need, the Sales Order picking sheet can also be emailed to the 
customer by defining settings in Default Delivery Options and Paperless Office Delivery 
Options (Customer Maintenance).

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Scheduled Email Attachments

On the Form Maintenance Main tab, the Scheduled Attachments button has been added. 
Use this time-saving feature to set up and schedule additional attachments to email with a 
form.

Option to View All Journal and Register PDF documents by Module

The new Role Maintenance security option Allow Viewing of Journal and Register PDF 
Documents for Users Without Permissions to Task allows users to view Journal and 
Register PDF documents when they do not have permissions to the task that created the 
PDF. For example, a user can view PDF documents for the Cash Receipts Register, even 
if they do not have permissions to the Cash Receipts Register task.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Improvements to Email Messages

In Electronic Delivery Message Maintenance, the selections at the Document field have 
been expanded so that you can now create unique email messages for specific 
documents in a document group. For example, in the S/O Invoice document group, you 
can create unique messages for a credit memo or debit memo.   

Also, use the new Copy From button to copy an existing email message record and then 
modify it to meet your business needs.
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Production Management
The following change was made in the Production Management module.

Option to Print Items with Zero Quantity Short Balances

On the Material Shortage Report, you now have the option to print items that have all 
entries with a quantity short equal to zero. 

Purchase Order
The following change was made in the Purchase Order module.

Option to Skip Prompt for Cancellation Code

The Cancel/Reason Code Req When Deleting Orders/Quotes field in Purchase Order 
Options has been enhanced. You now have the option to skip being prompted for a 
cancellation code when a purchase order/quote or line is deleted and a cancel/reason 
code is not required.

Sales Order
The following changes were made in the Sales Order module.

Option to Suppress Zero Cost Warning Message

You have the option to suppress the Zero Cost Warning message that appears in Sales 
Order data entry with the new Role Maintenance security option, Display Zero Cost 
Warning for Miscellaneous and Special Items.

We're listening! This idea was a suggestion from 90 Minds, Inc., and it received 
multiple votes on the Sage 100 ideas site. 

Option to Suppress Purge Message

You have the option to suppress the purge message that appears after printing the Daily 
Shipment Report with the new Role Maintenance security option, Allow Purging of Daily 
Shipment Report.
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Sales Order

View Sales Order Total

The Order Total field has been added on the Sales Order Entry Payment tab and is 
available when entering a credit card deposit. The Invoice Total field has been added on 
the S/O Invoice Data Entry Payment tab.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Option to Print Lot/Serial Information

On the S/O Additional Packing List form, you now have the option to print lot/serial 
information for items, which includes lot code source and country of origin.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.

Option to Skip Prompt for Cancellation Code

The Cancel/Reason Code Req When Deleting Orders/Quotes field in Sales Order 
Options has been enhanced. You now have the option to skip being prompted for a 
cancellation code when a sales order/quote or line is deleted and a cancel/reason code is 
not required.

Access Sales Order Memos in Shipping Data Entry

The Memo button has been added next to the Order Number field in Shipping Data Entry. 
To use the Memo button, enable it in Memo Manager Maintenance.

We’re listening! This idea was a suggestion on the Sage 100 ideas site. Visit the 
ideas site to share your ideas and vote for your favorites.
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Visual Integrator
The following changes were made in the Visual Integrator module.

Improvements in the Expression Builder

The following improvements have been made for creating complex expressions and 
calculations in the Expression Builder for import or export jobs.

 l When selecting a field or operator, the selected string is now inserted where the 
cursor is located in the calculation at the Expression Text field.

 l The less than sign (<) and greater than sign (>) have been added to the list of 
Functions & Operators.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

New Operations in Import Field Properties

The Add Value and Subtract Value operations have been added in Import Field 
Properties to perform on the import field. You can use these operations for numeric and 
date fields only.

Your Sage 100 business partners at work! This idea was a suggestion from 90 
Minds, Inc. where “More Minds Are Better Than One.”

Integrations
The following integrations are available in Sage 100 2026.

New Options for Sage Supply Chain Intelligence Integration

New options have been added that enable you to set additional requirements that 
determine which purchase orders sync from Sage 100 to Sage Supply Chain Intelligence.

 l Use the Allow Sync for Sage Supply Chain Intelligence check box in Vendor 
Maintenance to determine if purchase orders for a specific vendor sync.

 l Use the Sync to Sage Supply Chain Intelligence check box in Purchase Order Entry 
to determine if a specific purchase order syncs. This check box can only be viewed in 
Purchase Order History Inquiry.
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